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File menu commands
The File menu offers the following commands:

Open Opens an image file.
Next Opens the next file.
Previous Opens the previous file.
Scan Forward Scan files in alphabetical order.
Scan Back Scan files in reverse order.
Stop Scan Stop scanning files.
Close Closes an image.
Save As Saves an image to a BMP file.
Print Prints an image.
Print Preview Displays the image on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Exit Exits PDSWIN.
File 1, 2.. Open most recently used files.



Edit menu commands
The Edit menu offers the following commands:

Copy Copies an image to the clipboard.



View menu commands
The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Zoom Turns zoom mode on or off.
Image Info Shows or hides information from the image label.
 Brightness Shows or hides a dialog to adjust brightness and contrast.

 



Window menu commands
The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple images in the application window:

New Window Creates a new window that views the same image.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ...Goes to specified window.



Color menu commands
The Color menu offers the following commands:

Load Palette Load a color palette.
Reset Palette Reset color palette to default.



Options menu commands
The Options menu offers the following commands:

Auto-Bright Enable/disable automatic contrast stretch.
Scan pause Set pause between files when scanning.



Help menu commands
The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using Help Provides general instructions on using help.
About Displays the version number of this application.



Open command (File menu)
Use this command to open an image in a new window.    PDSWIN displays the Open dialog 
box, in which you can locate and open the desired file.    You can open multiple images at 
once.    Use the Window menu to switch among the multiple open images.    See Window 1, 
2, ... command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box
The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open.    Supported file types are:
Compressed files (.IMQ)
Browse files (.IBG)
Uncompressed files (.IMG)
Color files (.RED, .GRN, .SGR, .VIO)
When the dialog is displayed from a Load Palette command, file types are:
PDS (IMDISP) palettes (.PAL)
FRACTINT palettes (.MAP)

Drives
Select the drive which has the file that you want to open. 

Directories
Select the directory which has the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Next command (File menu)
Use this command to open the next file on the disc.    The file will be displayed in the 
currently active window.    PDSWIN searches the currently active file's directory (in 
alphabetical order) and opens the next file with with the same extension.    If there are no 
more files in the current directory, it will search subdirectories and then parent directories 
until it finds a file or runs out of places to look.

Shortcuts

Toolbar:
Keys: ALT+N



Previous command (File menu)
Use this command to open the previous file on the disc.    The file will be displayed in the 
currently active window.    PDSWIN searches the currently active file's directory (in reverse 
alphabetical order) and opens the next file with with the same extension.    If there are no 
more files in the current directory, it will search parent directories    and then subdirectories 
until it finds a file or runs out of places to look.

Shortcuts

Toolbar:
Keys: ALT+P



Scan Forward command (File menu)
Use this command to browse through multiple files on a disc.    The files will be displayed in 
the currently active window.    PDSWIN searches for files in the same manner as the next 
command.    After a new image is displayed PDSWIN will pause for the time specified by the 
Scan pause option, and then proceed to the next file.    This will continue until a Stop scan 
command is received, or the last file is displayed.

The scan forward command only works when the toolbar is visible.

Shortcuts

Toolbar:



Scan Back command (File menu)
Use this command to browse through multiple files on a disc.    The files will be displayed in 
the currently active window.    PDSWIN searches for files in the same manner as the 
previous command.    After a new image is displayed PDSWIN will pause for the time 
specified by the Scan pause option, and then proceed to the next file.    This will continue 
until a Stop scan command is received, or the last file is displayed.

The scan back command only works when the toolbar is visible.

Shortcuts

Toolbar:



Stop Scan command (File menu)
Use this command to halt a Scan Forward or Scan Back.    The scan will stop as soon as the 
image that is currently being read is displayed.

Shortcuts

Toolbar:
Keys: ESC



Next file error dialog
This dialog appears when PDSWIN has encountered a problem while trying to open a new 
file in an already open    window.    Click one of the buttons to tell the program what to do 
with the open window:
Skip to next file Skip over the problem file and try to open the next one.
Return to last file Go back to the file that was last displayed.
Skip to next directory Skip all the files in this directory and open the next available 

file.
Cancel Give up and close the window.



Close command (File menu)
Use this command to close all windows containing the active image.

You can also close a image by using the Close icon on the image's window, as shown below:



Save As command (File menu)
Use this command to save and name the active image.    PDSWIN displays the Save As 
dialog box so you can name your image.    The file is always saved as a Windows bitmap 
(.BMP) file. 
 

Shortcuts

Toolbar:



File Save As dialog box
The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save an image with a different name.    A filename can contain up
to eight characters and an extension of up to three characters.    PDSWIN adds the 
extension you specify in the Save File As Type box.

Save File As Type
Select the type of file you want to save:
Windows bitmap files(.BMP)
This is the only file type that PDSWIN currently knows how to save.

Drives
Select the drive in which you want to store the image.

Directories
Select the directory in which you want to store the image.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)
Use the numbers and filenames listed at the bottom of the File menu to open the last four 
images you closed.    Choose the number that corresponds with the image you want to 
open.



Exit command (File menu)
Use this command to end your PDSWIN session.    You can also use the Close command on 
the application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Copy command (Edit menu)
Use this command to copy the image onto the clipboard.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Toolbar command (View menu)
Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in PDSWIN, such as File Open.    A check mark appears next to 
the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    
The toolbar provides quick mouse access to many tools used in PDSWIN,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open an image file.

Save the active image as a .BMP.

Copy the image to the clipboard.

Print the active image.

Display the copyright notice and version number.

Get help.

Turn zoom mode on and off.

Show or hide the Image Info dialog.

Show or hide the Brightness/Contrast dialog.

Scan back through files.

Open the previous file.

Stop scanning through files.

Open the next image file.

Scan forward through files.



Status Bar command (View menu)
Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and zoom factor for the 
current window. A check mark appears next to the menu item when the Status Bar is 
displayed.



Status Bar

The status bar is displayed at the bottom of the PDSWIN window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the 
description of the toolbar button command you wish not to execute the command, then 
release the mouse button while the pointer is off the toolbar button.

The right area of the status bar shows the zoom factor of the active image.



New command (Window menu)
Use this command to open a new window with the same contents as the active window.    
You can open multiple image windows to display different parts or views of an image at the 
same time.    If you change the contents in one window, all other windows containing the 
same image reflect those changes.    When you open a new window, it becomes the active 
window and is displayed on top of all other open windows.



Cascade command (Window menu)
Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)
Use this command to arrange multiple opened windows in a non-overlapped fashion.



Window Arrange Icons Command
Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open image window at the bottom of the main window, then some 
or all of the icons may not be visible because they will be underneath this image window.



1, 2, ... command (Window menu)
PDSWIN displays a list of currently open image windows at the bottom of the Window 
menu.    A check mark appears in front of the file name of the active window.    Choose an 
image from this list to make its window active.    



Load Palette command (color menu)
Use this command to load a color palette for the currently active image.    PDSWIN can read 
PDS (IMDISP) format .PAL files or FRACTINT format .MAP files.



Reset Palette command (color menu)
Use this command to reset the color palette for the currently active image to the default 
linear gray scale palette.



Auto-Bright command (options menu)
This command enables or disables automatic contrast stretching when a new file is opened.
If Auto-Bright is enabled, PDSWIN will examine images when they are opened and try to 
optimize brightness and contrast settings for them.

Changing the Auto-Bright option has no effect on images that are already open.    Use the 
Auto button in the Brightness/Contrast dialog on open images.



Scan Pause command (options menu)
The scan pause command allows you to set a pause when PDSWIN is browsing images using the scan forward or 
scan back commands.    Enter the number of seconds to pause between images in the dialog box that is displayed.



Index command (Help menu)
Use this command to display the opening screen of Help.    From the opening screen, you 
can jump to step-by-step instructions for using PDSWIN and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)
Use this command for instructions about using Help.



About command (Help menu)
Use this command to display the copyright notice and version number of your copy of 
PDSWIN.



Context Help command 

Use the Context Help command to obtain help on some portion of PDSWIN.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the PDSWIN window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcuts

Toolbar:
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and image.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Image Control-menu button
Maximize button
Minimize button
Name of the application
Name of the image
Restore button



Scroll bars

Displayed at the right and bottom edges of the image window.    The scroll boxes inside the 
scroll bars indicate your vertical and horizontal location in the image.    You can use the 
mouse to scroll to other parts of the image.



Size command (System menu)
Use this command to display a four-headed arrow so you can size the active window with 
the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)
Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7
Mouse: Drag the title bar at the top of the window.



Minimize command (application Control menu)
Use this command to reduce the PDSWIN window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)
Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a image window.



Next Window command (Image Control menu)
Use this command to switch to the next open image window.    PDSWIN determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (Image Control menu)
Use this command to switch to the previous open image window.    PDSWIN determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)
Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single image, the Close command on the 
image Control menu closes only one window at a time.    You can close all windows at once 
with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes an image window

ALT+F4 closes the main window or dialog box



Restore command (Control menu)
Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.

Shortcut

Mouse: To restore a maximized window click the restore icon  on the title bar, or 
double click on the title bar.

To restore a minimized window double click on its icon.



Switch to command (application Control menu)
Use this command to display a list of all open applications.    Use this "Task List" to switch to
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>



Print command (File menu)
Use this command to print an image.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

PDSWIN will stretch the image to fill as much of the page as it can.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box
The following options allow you to specify how the image should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire image.
SelectionNot currently implemented.
Pages PDSWIN always prints one page.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Preview command (File menu)
Use this command to display the active image as it would appear when printed.    When you
choose this command, the main window will be replaced with a print preview window in 
which the page will be displayed in its printed format.    The print preview toolbar offers you
options to zoom in and out of pages and initiate a print job.



Print Setup command (File menu)
Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box
The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the image is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Print Preview toolbar
The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Progress Dialog
The Printing dialog box is shown during the time that PDSWIN is sending output to the 
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Zoom Command (View menu)
This command allows you to zoom in and out on a part of the image.
When PDSWIN is in zoom mode, its cursor will change to a magnifying glass  when it is 
over an image.    To zoom in, move the cursor over the area you want to see and click the 
left mouse button.    To zoom out, click the right mouse button.    The zoom factor for the 
active image is shown on the status bar.

Shortcuts

Toolbar:
Keys: ALT+Z



Image Info command (View menu)
Use this command to show or hide the Image Info Dialog.

Shortcuts

Toolbar:
Keys: ALT+I



Brightness command (View menu)
Use this command to show or hide the Brightness Dialog.

Shortcuts

Toolbar:
Keys: ALT+B



Image Info Dialog
The files that PDSWIN displays all start with a label section that has information about the 
image stored in the file.    This dialog box shows some of the information from the label.    
The contents of the box will vary, depending on where the file came from.



Brightness/Contrast dialog
Use these controls to enhance the brightness and contrast of the image you are viewing.    
Each pixel in the image is stored as a digital number (DN value) which indicates its 
brightness.    In most PDS images the values can be anywhere from 0 to 255; 0 means 
black, 255 means white, and the numbers in between indicate shades of gray.    Much of the
detail in an image is often concentrated in a fairly narrow brightness range.    The controls 
in this dialog allow you to make details in the image clear by modifying the way the DN 
values are displayed.

The dialog has the following controls:
The Brightness and Contrast sliders

Use the mouse to drag the slider handles up and down.
The Brightness and Contrast text boxes

Brightness and contrast numeric values are displayed and can be entered here from the 
keyboard.

The Graph
Use the mouse to drag the red and blue handles along the edges of the graph.    The 
graph also shows the brightest (DN high) and darkest (DN low) displayed values, and the 
image histogram, a graph (green lines) of the frequency of pixel values in the image.

The Negative checkbox
Converts the image to a photo-negative.

The Reset button
Returns all controls to their default values.

The Auto Button
Performs an automatic contrast stretch.    Use the Auto-Bright command in the options 
menu to auto-stretch files as they are read.

The Hide Button
Hides the dialog box.    Use the Brightness command to restore it.

The Options Button
Lets you set options which affect the appearance of the brightness dialog.

The Show/Hide Graph button 
Expands or shrinks the dialog to show or hide the graph.

Tip:
An easy way to get a good setting is to:
1. Drag the red (upper right) graph handle to the left along the top of the graph until the
bright parts of the image start to turn white.
2. Drag the blue (lower left) graph handle to the right along the bottom of the graph 
until the dark parts of the image turn black.





Brightness options dialog
This dialog lets you set options which affect the Brightness/Contrast dialog.
The dialog has the following controls:
Histogram checkbox

Enables/disables display of the image histogram.
Grid checkbox

Enables/disables display of grid lines in the graph.
DN Values checkbox

Enables/disables display of DN High and DN Low values in the graph.



Registration
If you'd like to receive notification of future upgrades, or if you have any suggestions, 
requests, comments, bug reports, or whatever, drop me a line.

Steve Green
1121 A Duchow Way
Folsom, CA 95630

Email: sgreen@well.com

Conditions on use: 
This version of PDSWIN is copyrighted freeware.    As such, it may be freely copied and 
distributed but may not be sold.    PDSWIN may not be given away with commercial 
products without explicit permission from the author.

There is no warranty of PDSWIN's suitability for any purpose, nor any acceptance of 
liability, express or implied.

The author of this program is not affiliated with NASA, The National Space Science 
Distribution Center, or Hughes STX corporation.



Ordering CD-ROMS from NASA
All information shown below is subject to change without notice.

CD-ROMs can be ordered from the National Space Science Data Center (NSSDC).    The 
NSSDC is operated for NASA by Hughes STX Corporation.

The information shown below was taken from the August, 1993 "NASA SPACE AND EARTH 
SCIENCE DATA ON CD-ROM" catalog.    For updated information and more details, request 
the latest version from the address listed below.

NASA CD-ROMS can be ordered from:
National Space Science Data Center
Code 633.4
Goddard Space Flight Center
Greenbelt, MD 20771

Phone: (301) 286-6695
Fax: (301) 286-1771
E-Mail: request@nsscda.gsfc.nasa.gov

Credit card orders are accepted.

General price information:
The CD-ROMS cost $20 for the first disc and $6 for each additional disc per order,
per data set.    There are also shipping and handling charges. 

Fees may be waived...
On up to six discs per year "as resources permit" for ...

1. NASA installations, NASA contractors, or NASA grantees.
2. Other U.S. government agencies, their contractors, or their grantees.
3. Accredited universities or colleges.
4. State or local governments.
5. Non-profit organizations.

... if the discs are to be used for scientific or specific college-level educational purposes.
K-12 educators can get a free sample disk if they can't pay the $20.
See the catalog or ask NSSDC for details.

Available sets include:
Voyagers to the Outer Planets.    12 discs, $86.
Viking Orbiter images of Mars (raw data).    14 discs, $98.
Mars Digital Image Model (processed Viking Orbiter data).    14 discs, $92.
Magellan Venus Mosaic Image Data Records (Radar map).    80 discs, $494.
Magellan Venus Global Data Records.    1 disc, $20.
Galileo Cruise Imaging of Venus, Earth, and The Moon.    5 discs, $44.
International Halley Watch.    24 discs, $158.

Note: You can order partial subsets of these sets as explained in the general pricing 
information above.

Note: IMDISP (for DOS) and Image4PDS (for Mac) are also available at $9 per copy.
These programs are viewers similar to PDSWIN.    They are not Windows programs.

Note: This version of PDSWIN doesn't fully    support all of these data sets.    See 
Supported CD-ROMS and files and Future upgrades.





Future upgrades
Some of the features I'd like to add to future versions PDSWIN are:

Near term:
Support for all available PDS image CD-ROMs.
Image enhancement.
Trim and resize.
Cut and paste, map and merge.
Palette load.
Rotate and mirror.
More formats for save.
Gamma control.

Long Term:
Integrated database.
OLE.
Mosaicking.
Color composits.
Radiometric and Geometric corrections.
Illumination correction.
Camera Calibration.
Educational help.
Map and place name references.

These and other improvements will come when and if I get the time and energy to do them.
If you would like to be notified of future upgrades, see Registration.    This version of 
PDSWIN is free, there may be a charge for some future versions.    If you have any 
suggestions, comments, or, if you can contribute information, data, source code (C or C++ 
preferred) please contact me.    I am particularly interested in digital image processing 
software, geometric data for the image sets, information on the spacecraft and their 
imaging systems, and research results and interpretive information concerning the images 
themselves.



Recommended hardware and software
PDSWIN requires Windows 3.1.    It has not been tested with any other version of Windows.   
CD-ROM caching (available under DOS version 6.2 or as an add-on from several sfotware 
manufacturers) is recommended for best speed. 

CPU:
'386 or better required.
'486 or better recommended for fastest performance.

Memory (RAM):
2 Mbytes Untested, may not work.
4 Mbytes Should be OK for limited use.
8 Mbytes Recommended.
The more the merrier.

CD-ROM drive:
Required to view CD-ROMS, double-speed recommended.

Video:
256 color VGA required.    (The program may work with less but the images won't look 
very good.)

640x480 resolution is OK, 800x600 is a good general purpose mode, 1024x768 can show
most of an 800x800 Voyager image without zooming out.    Higher resolution hardware is 
great if you can afford it.

8 bit (256 color) is fine for most purposes.    16 bit (65K color) doesn't add much.    24 bit 
(16 million color) cards are best.    Most 8 bit and 16 bit video cards are really only "5 bit" 
cards when they display gray scale images like those on the NASA discs.    This means 
they can only display 32 shades of gray, some "banding" may be visible on smoothly 
shaded images.

Windows graphics accelerators can speed things up a lot, especially if they accelerate 
"DIBtoDevice" and "StretchDIB" functions.

I get a good combination of speed and accuracy using a Diamond Stealth 24 bit video 
card in 800x600, 256 color mode.



Acknowledgements
The decompression routine used by PDSWIN is based on the source code supplied on the 
Voyager CD-ROMs.

PDSWIN was inspired by the Voyager CD-ROM data set created by:
The Voyager Experiment Team, team leader, Dr. Bradford A. Smith.
The Planetary Data System.
The National Space Science Data Center.



Supported CD-ROMs and files
This version of PDSWIN has been tested on the following CD-ROM data sets:

Voyagers to the Outer Planets
All

Viking Orbiter Images of Mars
All

Mars Digital Image Model
Vol. 1-13: All, except a few that are too large for Windows to handle.
Vol 14: Contains GIF format images, not supported by this version of PDSWIN.

Magellan Mosaic Image Data Records
All

Magellan GxDRs
All

Galileo Cruise Imaging
All

International Halley Watch
All browse files, all 8 and 16 bit .IMG files.    Not supported are 16 bit compressed .IMQ 
files and 32 bit uncompressed .IMG files.

PDSWIN can also be used with uncompressed (.IMG) files that are found in space and 
astronomy sections of some computer bulletin boards.

In general, PDSWIN should be able to read any 1, 4,    8, or 16 bit PDS image file.

Future upgrades will be tested on other data sets.



Voyagers to the Outer Planets
The 12 Disks in this set contain approximately 26,000 800x800 black and white images 
from Voyager 1 and Voyager 2's encounters with Jupiter, Saturn, Uranus, Neptune, and their
moons.

Discs 1-3 Uranus
Discs 4,5 Saturn
Discs 6-8 Jupiter
Discs 9-12 Neptune

The last disc for each planet (3, 5, 8, 12) includes    200x200 "browse" files for each image 
in the planet's set.

Best of: Disc 6--The first pictures from Voyager 1.    Lots of spectacular images of Jupiter 
and it's moons.



Mars Digital Image Model
This 14 disc set contains processed images from the Viking Orbiters.    A real triumph of 
image processing, this set is highly recommended for anyone interested images of Mars.    
The U.S. Geological Survey took the raw Viking Orbiter images, cleaned them up, and 
processed them into a complete image map of Mars at several resolutions.    All images are 
8 bit gray scale unless otherwise noted.

Volumes 1-6:
Planet-wide coverage at 256 pixel/deg. (0.231 KM/pixel)    and 64 pixel/deg. (0.925 
KM/pixel) resolution.

Volume 7:
Planet-wide coverage at 64 pixel/deg. (0.925 KM/pixel) and 16 pixel/deg. (3.702 KM/pixel)
resolution.    Also, a complete 16-bit topographic map at 64 pixel/deg. (0.925 KM/pixel), 
16 pixel/deg. (3.702 KM/pixel) and 4 pixel/deg. (14.8 KM/pixel) resolution.

Volumes 8-13:
Color filtered images at 64 pixel/deg. (0.925 KM/pixel) resolution.    Red, green, and violet 
filtered images are provided in separate files for each area covered.    Coverage isn't as 
complete as in vols. 1-6, many of the tiles have blank spots where color information 
wasn't available.    Theoretically these files could be combined into true-color, 24-bit 
images, but the software to do this isn't generally available.    A future version of PDSWIN 
should (I hope) solve this problem.    These volumes each also include gray-scale 
coverage of the entire planet at 16 pixel/deg. (3.702 KM/pixel). 

Volume 14:
 8 bit color GIF format images produced from the data on vols. 8-13.    This version of 
PDSWIN doesn't read GIF files, but there are many other viewers available which do.

Volumes 1-13 also have a shaded relief map at 16 pixel/deg. (3.702 KM/pixel) and 4 
pixel/deg. 14.8 KM/pixel) resolution.

Volumes 8-14 have a "special" subdirectory with orthographic, point-perspective, and 
oblique views of selected areas of the planet. 

The areas covered by vols. 1-6 and 8-13 are:

Vol. 1,    8.    Vastitas Borealis Region.    The north polar region of Mars    southward from the 
pole to a latitude of 37.5 deg. North.

Vol. 2,    9.    Xanthe Terra Region.    37.5 deg North latitude to 52.5 deg South latitude, and 0
deg longitude to 90 deg. West longitude.    Includes Valles Marineris.

Vol. 3, 10.    Amazonis Planitia Region. 37.5 deg. North latitude to 52.5 deg. South latitude, 
and 90 deg West longitude to 180 deg West longitude.    Includes Olympus Mons.
                                        
Vol. 4, 11.    Elysium Planitia Region.    37.5 deg North latitude to 52.5 deg. South latitude, 
and 180 deg. West longitude to 270 deg West longitude. 

Vol. 5, 12.    Arabia Terra. 37.5 deg North latitude to 52.5 deg South latitude, and 270 deg. 
West longitude to 0 deg. West longitude. 

Vol. 6, 13.    Planum Australe Region.    The South polar region of Mars    northward from the 
pole to a latitude of 52.5 South latitude.

Best of: Disc 7 has medium resolution images of the whole planet plus the nifty topo 



maps.



Viking Orbiter Images of Mars
The raw image data from the Viking orbiters on 14 discs.    The Images are stored by orbit 
number; each image is available as a compressed 1056 x 1202 pixel .IMQ file and    an 
uncompressed 264 x 300 "browse" (.IBG) file.    Many of the images have a lot of noise and 
crud in them;    unless you like your data raw, I suggest you try the Mars Digital Image 
Model data set instead of this one.    All images are in 7 bit (stored as 8 bit) gray-scale.

Best of: Pick a disc, go to the browse directory, and start scanning.    You'll know its time to 
stop when you start seeing faces.



Magellan Venus Radar Mosaics
This 80 disc set contains processed images of Venus from Magellan's synthetic aperture 
radar.    Most of the planet is covered at several resolutions.    The images are organized as 
"Mosaic Image Data Records" (MIDRs), 8,192 x 7168 sample projections of an area the 
planet.    Each MIDR is stored in a subdirectory as 56 1,024 x 1,024 files.    There is also a 
1,024 x 896 browse image for each MIDR.    Each disc contains 10 MIDRs.

Full-resolution MIDRs (F-MIDRs) are available for about 15% of the planet.    Image 
resolution is    1407.4 pixel/deg. (75 M/pixel).    The following volumes contain F-MIDRs: 1, 3-
11, 13, 15, 17, 18, 23-29, 32, 35, 36, 38, 39, 42, 44-46, 49, 50, 52, 53, 55, 56, 58, 59, 62-
68, 70-77, 80.

Compressed once MIDRs (C1-MIDRs) cover most the planet at a resolution of 469.1 
pixel/deg. (225 M/pixel).    The following volumes contain C1-MIDRs: 2, 12, 14, 16, 19, 20, 
21, 22, 30, 31, 33, 34, 37, 40, 41, 43, 47, 48, 54, 57, 60, 61, 69, 78, 79.

Compressed twice MIDRs (C2-MIDRs) cover most the planet at a resolution of 156.4 
pixel/deg. (675 M/pixel).    The following volumes contain C2-MIDRs: 30, 33, 34, 37, 43, 51, 
54, 61, 69.

Compressed thrice MIDRs (C3-MIDRs) cover most the planet at a resolution of 52.1 
pixel/deg. (2025 M/pixel).    The following volumes contain C3-MIDRs: 69,78.

See also: Magellan GxDRs

Best of: The C3-MIDRs on vols. 69 and 78 cover the planet in a manageable number of 
files.



Magellan GxDRs
This disc contains processed data from Magellan's radar mapping mission to Venus.    The 
images show reflectivity, emissivity, slope, and topography.      Mercator, sinusoidal, and 
polar projections are included for each data type.    Resolution is 22.76 pixel/deg. (4641 
M/pixel).    Emissivity and topography images are 16 bit/pixel gray-scale; slope and 
reflectivity images are 8 bit/pixel gray-scale.

See also: Magellan Venus Radar Mosaics

Best of: Check out the topographic images in the GTDR directory.    Load a topo color 
palette and teraform Venus.



Galileo Cruise Imaging
Images of Venus, Earth, and the Moon from Galileo's    fly-bys on the way to Jupiter.    The 
Images are 800 x 800 8 bit gray-scale; they haven't been processed.    The images aren't 
compressed and they include a lot of extra data, so they are relatively slow to read and a 
disc only holds 800 of them.    Venus images are on volume 2, Earth and the Moon are on 
volumes 3-6; volume 1 hadn't been released yet at this writing.

Best of: Vol. 2 for Venus, vol. 3 for Earth.



International Halley Watch
24 discs with lots of images of Comet Halley.    Most of the images are scans of photographs
made from ground-based telescopes.    Volumes 25 and 26 will have images made in-situ by
spacecraft, they weren't available yet at the time this was written.

Best of: Vol. 18 has browse images from the first 18 discs.




